ANNUAL CLINIC AND PROVIDER REGISTRATION
2018 INSTRUCTIONS
Required Registration of Minnesota Physician Clinics
All physician clinics in the state of Minnesota are required to register annually for the Minnesota Department of
Health’s (MDH) Statewide Quality Reporting and Measurement System (SQRMS) through MN Community
Measurement’s (MNCM) Data Portal. The instructions in this guide are provided to assist clinics in registering
their clinic sites and providers.

Registration deadline is Friday, February 9, 2018
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Summary of Changes

• There have been NO changes in registration requirements for 2018.
• Clarity added to guidance regarding submitting data from multiple clinics as a
single entity (Roll-Up) in Section III.
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Section I: Registration Requirements
Each year, all eligible clinics and providers must register on the MNCM Data Portal. This includes all clinics and
providers that have and have not registered previously as well as clinics and providers that may not be required
to report on clinical quality measures.
Clinic Registration Requirements
All individual clinic sites that meet all of the following criteria must register, regardless of whether the clinic is
eligible to report data on clinical quality measures:
Located within the state of Minnesota
Provides primary or specialty care ambulatory services for a fee
Has one or more physicians providing services
Provided services to patients at any time during the 2017 calendar year (01/01/2017 to 12/31/2017);
this includes clinics that were open for only a portion of the year
• The clinic site location is a building, separate space or an entity with a street address that is a functional
unit easily understood by patients/consumers
These requirements apply to existing clinics as well as newly opened/acquired clinics, standalone Urgent Care
clinics and hospital-based outpatient clinics. Satellite clinics that bill services through a main site are not
required to register.
•
•
•
•

Provider Registration Requirements
Clinics meeting the above requirements must register the following provider types. These providers must have
delivered services billed by the clinic during the 2017 calendar year (01/01/2017 to 12/31/2017).
Medical Doctor (MD), includes physicians who have medical degrees from other countries (e.g., MBBCH,
MBBS, MBCHB), and those who are locum tenens, residents, and fellows.
• Doctor of Osteopathy (DO)
• Physician Assistant (PA)
• Advanced Practice Registered Nurse includes, but is not limited to, Certified Nurse Practitioner, Certified
Nurse Specialist, and Certified Nurse Midwife.
Provider registration is NOT tied to data submission for clinical quality reporting. Providers that are required to
register may not necessarily be required to submit data for clinical quality measures and providers that are not
required to register may be required to submit data.
•

For the purposes of SQRMS, dieticians, licensed counselors, pharmacists, physical therapists, podiatrists,
occupational therapists, optometrists or others not listed above are not considered eligible providers.
However, these provider types may be registered in the MNCM Data Portal in the Other Providers step for
purposes other than SQRMS, such as federal reporting programs. For more information about registering these
providers please see the Addendum to these instructions or contact MNCM at support@mncm.org.
Further definition of physician clinic and clinical staff can be found in Minnesota Administrative Rules, Chapter
4654 (https://www.revisor.mn.gov/rules/?id=4654&view=chapter#rule.4654.0200). See Appendix A for more
information about SQRMS.
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Section II: Medical Group Registration
The first page displayed after logging on to the MNCM Data Portal is the Home tab. A list of registration steps
that must be completed are shown on this page. This page can be accessed from other pages in the MNCM Data
Portal by clicking on the Home tab.
The Medical Group is the overarching practice structure under which clinic and provider registration is
maintained. Registration of the Medical Group must be completed first.

Previously registered medical groups:

1. Log in to the MNCM Data Portal and click on My Medical Group under the Portal Setup section on the
Home tab. This can also be accessed by clicking on the Group tab.
2. Review the medical group information.
If changes are necessary, click Edit My Medical Group and make additions/corrections to the
medical group information already listed in the MNCM Data Portal. Click Save.
o When registering medical group and clinic information, be aware that the names
registered in the MNCM Data Portal will be used for a variety of public reporting
purposes including MNHealthScores.org, the Health Care Quality Report, the Health
Care Disparities Report, the Health Equity of Care Report and numerous MDH products.
See Appendix B for naming tips.
3. Review the medical group contacts. Maintaining up-to-date contacts is important. All contacts in the
MNCM Data Portal may receive emails and/or telephone calls.
•

•

Add new contacts by clicking Add New Contact and entering the contact information. Click Save.

•

Remove contacts by clicking Remove Contact next to the contact’s name.

•

Designate a primary contact.
o Typically, the primary contact is the person from the medical group who uploads and
submits data files for the clinical quality measures, receives communications from
MNCM about data submission and other important updates, and completes the medical
group’s annual registration of the clinics and clinical staff on the MNCM Data Portal. Upto-date primary contact information is vital to ensure that MNCM communications are
received. Remember to update contact information when there are personnel changes.

At least one contact is required. Medical groups are strongly encouraged to provide a minimum of
two individuals as contacts.
4. Once the information is reviewed and updated as needed, confirm the medical group and contact
information by clicking Done.
•

Newly registering medical groups:

Contact MNCM at support@mncm.org to request a Medical Group ID. See Appendix C for instructions to
request an MNCM Data Portal User account.
1. Log in to the MNCM Data Portal and click My Medical Group under the portal setup section on the
Home tab. This can also be accessed by clicking on the Group tab.
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2. Click Edit My Medical Group and enter the required medical group information. See Appendix D for
information required for registration.
When registering medical group and clinic information, be aware that the names registered in
the MNCM Data Portal will be used for a variety of public reporting purposes including
MNHealthScores.org, the Health Care Quality Report, the Health Care Disparities Report, the
Health Equity of Care Report and numerous MDH products. See Appendix B for naming tips.
3. Select an Electronic Medical Record (EMR) vendor from the drop-down list or select “No EMR” if the
medical group/clinic does not use an EMR. Select “Other” if the EMR vendor is not listed, and enter the
EMR vendor. Select a second EMR vendor if two vendors are used in the clinic/medical group.
4. Read each question listed, and select the appropriate answer for each. When fields are complete, click
Save.
5. Scroll down to the contacts section. Click Add a Contact to add contacts for the clinic/medical group. If
there is not a contact person for a contact type, leave it blank.
•

At least one contact is required. Medical groups are strongly encouraged to provide a minimum
of two individuals as contacts.
• Maintaining up-to-date contacts is important. All contacts in the MNCM Data Portal may receive
emails and/or telephone calls.
6. Click Assign to assign the contact type.
7. Select one person from the medical group as the primary data contact by clicking Make Primary by the
appropriate contact. Identifying a primary data contact is a required step.
• Typically, the primary contact is the person from the medical group who uploads and submits
data files for the clinical quality measures, receives communications from MNCM about data
submission and other important updates, and completes the medical group’s annual registration
of the clinics and clinical staff on the MNCM Data Portal. Up-to-date primary contact
information is vital to ensure that MNCM communications are received. Remember to update
contact information when there are personnel changes.
8. To confirm the medical group and contact information; click Done.
•
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Section III: Clinic Site Registration
Clinic site registration must be completed after registration of the medical group. Register all clinic sites that
meet the criteria detailed in Section I. When a new clinic is entered, a MNCM clinic ID will be created
automatically.

Medical groups with a single clinic location: If a medical group only has one clinic site, the clinic site must
still be registered. The information used to register the clinic will be the same as the medical group information.
Multi-Specialty Clinics: A clinic site that has multiple specialties located in one building (one street address)

has two registration options. If either of the options selected is a change from how the clinic was registered
previously, please contact MNCM at support@mncm.org.
Option 1: Register and report data as one single clinic site (one clinic ID). Select all specialties practiced
at the clinic.
Option 2: Register each individual specialty and the main clinic site in which the specialties are located
(each specialty and the main clinic site will have a unique clinic ID). Each specialty will report on
applicable clinical measures, and the “main” clinic site will be used for the purposes of reporting on the
HIT Survey and Patient Experience of Care Survey results. If a medical group chooses to register a clinic
by specialty:
•
•

The main clinic site must register all specialties offered at the clinic even if there is currently not an
applicable measure associated with a specific specialty.
Each department must register each specialty they practice.

Registration Option Examples:
Registration Option 1
(One unique clinic ID)
Northern Health Clinic

Registration Option 2
(Unique clinic IDs for each specialty department and
main clinic site)
Northern Health Clinic (main clinic)
Northern Health Clinic – Family Medicine
Northern Health Clinic – Internal Medicine
Northern Health Clinic – Cardiology
Northern Health Clinic – Endocrinology
Northern Health Clinic – Pediatric Medicine
Northern Health Clinic – Behavioral Health
Northern Health Clinic – Dermatology
Northern Health Clinic – Urgent Care
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Submitting data from multiple clinics as a single entity (Roll-Up): During the clinic registration process,
medical groups must indicate whether data from multiple clinics will be submitted as a single entity (i.e., roll-up
data from all clinic sites to be reported under one of the sites).
Medical groups whose clinics meet all of the following criteria may choose to roll-up data from all clinics to one
clinic site:
•

All clinics in the medical group have common ownership; AND

•

The total number of providers across all clinic locations in the medical group is no greater than 20 fulltime equivalents (FTEs); AND

•

All clinics in the medical group have a majority (more than half) of common providers working across
the multiple locations (these providers must rotate between all of the clinic locations in the medical
group).

If a medical group has more than 20 FTEs, no clinics within the medical group may roll-up data. Providers are
defined as: physicians, physician assistants, and advanced practice registered nurses.
Medical groups meeting criteria and choosing to roll-up must submit data from all clinic sites under one clinic.
Medical groups intending to submit data from multiple clinics as a single entity should contact MNCM at
support@mncm.org to verify that all criteria are met.

Previously registered medical groups:
1. Click Clinic Sites under the portal setup section on the Home tab. This can also be accessed by clicking on
the Clinics tab.
2. Review the clinic site information by clicking the far left Edit button in the Edit column.
•

Make additions/corrections to the clinic site information already listed in the MNCM Data
Portal. Click Save.
o When registering medical group and clinic information, be aware that the names
registered in the MNCM Data Portal will be used for a variety of public reporting
purposes including MNHealthScores.org, the Health Care Quality Report, the Health
Care Disparities Report, the Health Equity of Care Report and numerous MDH products.
See Appendix B for naming tips.
o If the clinic changed locations, update the clinic address.
o Clinic TIN is required.

•

If any clinic was closed or acquired by another medical group during the past year, locate the
Status section and choose “Inactive”. Enter the reason the clinic was inactivated.

If appropriate, indicate clinic affiliation. This only applies if a clinic is rolling-up to a single entity.
See criteria above.
3. Review the clinic site contact information by clicking the middle Edit button in the Contacts column.
Maintaining up-to-date contacts is important. All contacts in the MNCM Data Portal may receive emails
and/or telephone calls.
•

•

Add new contacts by clicking Add New Contact and enter the contact information. Click Save.

Helpline 612-746-4522 | E-mail support@mncm.org | MNCM Data Portal https://data.mncm.org/login
© MN Community Measurement, 2017. All rights reserved.
Page 5

Clinic and Provider Registration
2018 Instructions
•

Remove contacts by clicking Remove Contact next to the contact’s name.

•

Designate a primary contact.

•

At least one contact is required. Medical groups are strongly encouraged to provide a minimum
of two individuals as contacts per clinic.

• Click Finished when done adding clinic contacts and selecting a primary contact.
4. Review the clinic site specialties information by clicking the far right Edit button in the Specialties
column. Specialties chosen during this step will determine data reporting requirements for the clinic.
•

Register all specialties for each clinic based on services provided, even if the clinic does not have
providers who are board certified in that specialty.

•

If necessary, add or remove specialties offered at the clinic site. Click Continue.

•

Additional questions about a specialty may be asked. These questions are part of the measure
assignment process. Please answer the questions accurately to ensure appropriate assignment
of required measures. If you have questions about how to accurately answer these questions,
please contact support@mncm.org before continuing.

Review changes and click Done if correct. Click Edit Specialties if further changes need to be
made.
5. Once the information has been reviewed and updated as needed for all clinic sites, confirm the clinic site
information by clicking Done.
•

Newly registering medical groups:
1. Click on Clinic Sites under the portal setup section on the Home tab. This can also be accessed by clicking
on the Clinics tab.
2. Click Add New Clinic Site and enter all required clinic information. See Appendix D for information
required for registration. Note: For the clinic address, please enter the street address of the clinic in the
first address field; enter the suite number or other information (e.g., P.O. Box number) in the second
address field.
•

When registering medical group and clinic information, be aware that the names registered in
the MNCM Data Portal will be used for a variety of public reporting purposes including
MNHealthScores.org, the Health Care Quality Report, the Health Care Disparities Report, the
Health Equity of Care Report and numerous MDH products. See Appendix B for naming tips.

•

If appropriate, indicate clinic affiliation. This only applies if a clinic is rolling-up to a single entity.
If the medical group chooses to submit data in this way, select the primary clinic location under
which the data will be submitted for clinical quality reporting purposes. This primary clinic site is
considered the clinic affiliation under which the clinic site will be submitting data. DO NOT
choose a clinic affiliation for the primary site that other clinic sites will roll-up to.
o All individual clinic locations must be registered. Even if a medical group qualifies and
chooses to roll-up data as one entity for clinical quality reporting, all clinic locations
must still be registered.
o Please see requirements above to determine if a medical group qualifies to roll-up data
as one entity.
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•

Each distinct clinic location should have its own unique facility National Provider Identifier (NPI)
(unless the clinic is a rolled-up clinic OR a specialty department within of a larger clinic). Clinic
TIN is required.

•

Select the EMR vendor from the drop-down list, or check the box if the EMR vendor is the same
as the medical group’s EMR vendor. Select “No EMR” if the clinic does not use an EMR. Select
“Other” if the EMR vendor is not listed and enter the vendor.

•

Read each question listed and select the appropriate answer for each.

• When fields are complete, click Save.
3. Add clinic site contact information by clicking the middle Edit button in the Contacts column.
•

Enter a contact person for each contact type for each clinic, if available. Click Add a Contact for
each new contact person. If there is not a contact person for a contact type, leave it blank.
o At least one contact is required. Medical groups are strongly encouraged to provide a
minimum of two individuals as contacts per clinic.
o Maintaining up-to-date contacts is important. All contacts in the MNCM Data Portal may
receive emails and/or telephone calls.

•

Click Assign to assign the contact.

•

Select one person from the clinic as the primary data contact by clicking Make Primary by the
appropriate contact. Identifying a primary data contact is a required step.

• Click Finished when done adding clinic contacts and selecting a primary contact.
4. Add the clinic site specialties information by clicking the far right Edit button in the Specialties column.
Specialties chosen during this step will determine data reporting requirements for the clinic.
•

Register all specialties for each clinic based on services provided, even if the clinic doesn’t have
providers who are board certified in that specialty. Click Continue.

•

Additional questions about a specialty may be asked. These questions are part of the measure
assignment process. Please answer the questions accurately to ensure appropriate assignment
of required measures.

Review the changes. Click Done if correct. Click Edit Specialties if further changes need to be
made.
5. Once the information has been reviewed and updated as needed for all clinic sites, click Done to confirm
the clinic site information.
•
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Section IV: Provider Registration
Provider registration must be completed after the registration of the clinic sites. Register all providers that meet
the criteria detailed in Section I. See Appendix E for instructions, examples and tools to accurately calculate FTEs
for each provider.
Example Scenario
A provider from Medical Group A – Clinic 1 goes to
Medical Group A – Clinic 2 to provide care. Both clinics
bill for services rendered at their individual clinics.
Which clinic registers the provider?
A provider from Medical Group A – Clinic 1 goes to
Medical Group A – Clinic 2 to provide care. Clinic 1 bills
for all services provided at both clinics. Which clinic
registers the provider?

Appropriate Registration Protocol
Register the provider under both clinics as both clinics
billed for services.

A provider from Medical Group A – Clinic 1 goes to
Medical Group X – Clinic 99 to provide care. Medical
Group A – Clinic 1 bills for the services. Which medical
group and clinic registers the provider?

Register the provider under Medical Group A – Clinic 1
which bills for the services. However, Medical Group X
– Clinic 99 should indicate the specialty of the services
provided at their facility as part of clinic registration.

A provider from Medical Group A – Clinic 1 goes to
Medical Group X – Clinic 99 to provide care. Both
Medical Group A – Clinic 1 and Medical Group X –
Clinic 99 bill for the respective services. Which medical
group registers the provider?

Both medical groups register the provider for the time
the provider spends at the clinic within their medical
group, but they do not register the provider for the
time the provider spends at the other medical group.

Register the provider only under Clinic 1 which bills for
the services.

Provider Registration Process Flow Chart
STEP 1
Register all providers that
meet SQRMS criteria.

STEP 2
Complete Provider
Registration Quality Checklist

STEP 3
(OPTIONAL)
If desired, register additional
providers for other programs.
See Addendum

STEP 4
Review registered provider
information and confirm.

Previously registered medical groups:
1. Click on Providers under the portal setup section on the Home tab. This can also be accessed by clicking
on the Providers tab.
2. To download a list of previously registered providers and their information on the MNCM Data Portal,
click Download in Upload Format at the top of the provider list.
•

A Provider File template in CSV format will open with all of the provider information that was
registered previously.

• Execute the Save As function and save the file in Excel format (.xls or .xlsx).
3. Update the Provider File to reflect changes from the previous registration.
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•

Add new providers and delete providers no longer with the medical group.

•

Update each field as necessary (e.g., new clinic IDs, etc.) for providers who will be registered
again under the medical group.

Review the file for accuracy.
o Verify that all providers that meet the criteria detailed in Section I, including new
providers, are included in the file.
4. When all the information is updated, save the file keeping it in Excel format.
5. From the Excel file, save a new CSV-format file (.csv).
•

• See instructions in Appendix F for information about how to save a CSV file.
6. Upload the CSV file to the MNCM Data Portal on the Providers page.
NOTE: Uploading a new file will completely overwrite previously registered providers. Be sure all
providers active in the previous calendar year are present in the file.
Review the provider information on the MNCM Data Portal. If changes to the provider information are
necessary, make changes in the original Excel file, re-save as a CSV file with a new name and re-upload
the file. If no changes are necessary, click Continue.
Review the Provider Registration Quality Checklist. Every item must be checked before the provider file
can be fully submitted. Once every item has been read and checked, click Continue.
Optional: To register other providers for purposes other than SQRMS, please refer to the Addendum to
these instructions to complete the Other Providers step. If you do not wish to register other providers,
click Skip and continue to Step 10.
Review the provider information on the MNCM Data Portal. If changes to the provider information are
necessary, make changes in the original Excel file, re-save as a CSV file with a new name and re-upload
the file. If no changes are necessary, click Done to complete provider registration.
•

7.

8.
9.

10.

Newly registering medical groups:
1. Click Providers under the portal setup section on the Home tab. This can also be accessed by clicking on
the Providers tab.
2. Download and complete the Provider Template available in the MNCM Data Portal. See the Provider
Template Data Elements and Field Specifications and Appendix D for information that is required to
complete the template. Save the file in Excel format.
•

Access the template on the Providers tab or on the Resources tab by selecting Annual Clinic and
Provider Registration Information from the drop-down menu.

• Verify that all providers that meet the criteria detailed in Section I are included in the file.
3. From the Excel file, save a new CSV-format file.
• Please see instructions in Appendix F for information about how to save a CSV file.
4. Upload the CSV file onto the MNCM Data Portal on the Providers tab.
5. Review the provider information on the MNCM Data Portal. If changes to the provider information are
necessary, make changes in the original Excel file, re-save as a CSV file with a new name and re-upload
the file. If no changes are necessary, click Continue.
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6. Review the Provider Registration Quality Checklist. Every item must be checked before the provider file
can be submitted. Once every item has been read and checked, click Continue.
7. Optional: To register other providers for purposes other than SQRMS, please refer to the Addendum to
these instructions to complete the Other Providers step. If you do not wish to register other providers,
click Skip and continue to Step 8.
8. Review the provider information on the MNCM Data Portal. If changes to the provider information are
necessary, make changes in the original Excel file, re-save as a CSV file with a new name and re-upload
the file. If no changes are necessary, click Done to confirm provider registration.
Please note: The Provider File template is formatted correctly for uploading to the MNCM Data Portal. It is
important that the formatting remains the same. If needed, see formatting instructions in the Provider Template
Data Elements and Field Specifications.
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Provider Template Data Elements and Field Specifications
Column

Field Name

Details

A-C

Provider Name

Enter names for the following fields:
•
•
•

D

E

Provider ID
(created by
medical group)
National Provider
Identifier (NPI)

Excel Format
Last name (Column A)
Full first name (e.g., Robert versus Bob) (Column B)
Middle name if available (Column C)

Text

Leave this field blank for providers with an NPI listed in Column E.
For providers without an NPI (e.g., residents), enter a provider ID. This may be an ID used in the EMR
or a unique ID that is assigned by the medical group.

Text

Enter the unique 10-digit NPI for each provider being registered. Please review all entered NPIs to
ensure correct entry for each individual provider.
•

For residents without an NPI, enter ten 9s – (9999999999) (Remember to enter an ID in
Column E for providers without an NPI).

•

For providers with an NPI, use a distinct NPI value for each unique provider. Duplicating NPI
values may cause difficulty with correct attribution strategies in public reporting.

NPI is a unique identifier for individuals or organizations (clinics) that render health care. Health care
providers who are HIPAA-covered entities obtain an NPI to identify themselves in HIPAA standard
transactions.
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Column

Field Name

Details

Excel Format

F

Provider Type

Enter one of the following numerical codes for the applicable provider type:
1 = Medical Doctor (MD), including physicians who have medical degrees from other countries (e.g.,
MBBCH, MBBS, MBCHB), and who are locum tenens, residents, or fellows
2 = Doctor of Osteopathy (DO)
3 = Physician Assistant (PA)
4 = Advanced Practice Registered Nurse (e.g., Certified Nurse Practitioner, Certified Nurse Specialist,
Certified Nurse Midwife)
For purposes of SQRMS, dieticians, licensed counselors, pharmacists, physical therapists, podiatrists,
occupational therapists, optometrists or others not listed above are not considered eligible providers
and therefore not required to register. If you wish to register these providers for purposes other than
SQRMS, such as federal reporting requirements, they can be registered in the Other Provider step.
Please see the Addendum to these instructions or contact MNCM at support@mncm.org for more
information.
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Column

Field Name

Details

Excel Format

G

Board Certified
Specialty

Using the following list of codes, enter the code of the provider’s primary board certified specialty. If
the provider is a physician assistant, advanced practice registered nurse, or a resident, leave the field
blank. If a code is not listed for an applicable specialty, enter 99 Other – not listed.
10 Allergy/Immunology
20 Oncology/Hematology
6 Cardiology
21 Ophthalmology
11 Cardiovascular Surgery
22 Orthopedic Medicine/Surgery
12 Colon and Rectal Surgery
23 Otolaryngology
13 Dermatology
24 Pediatric/Adolescent Medicine
14 Emergency Medicine
31 Perinatology
7 Endocrinology
25 Physical Therapy/Rehabilitation Medicine
1 Family Medicine
8 Psychiatry/Behavioral Health
15 Gastroenterology
26 Pulmonary Medicine
5 Geriatric Medicine
32 Radiation Oncology
2 Internal Medicine
27 Radiology
16 Nephrology
28 Rheumatology
17 Neurology
29 Surgery
18 Neurosurgery
30 Urology
9 Obstetrics/Gynecology
99 Other – not listed
19 Occupational Medicine

H

Medical License
Number

Enter the medical license number of each provider listed in the file.

I

Clinic ID Primary

Enter the MNCM ID listed in the MNCM Data Portal for the clinic where the provider primarily
practices (e.g., the clinic ID of the clinic where the majority of the provider’s claims are billed from).
Do not enter the medical group ID.
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Column

Field Name

Details

Excel Format

J

FTE Clinic Primary

Enter the full-time equivalent (FTE) value of each provider in number format (e.g., 0.60, 0.75, 1.00)
for the primary clinic site. Refer to Appendix E for assistance.

Number

If the FTE is less than 0.1, round up to 0.1.
K, M, O,
Q, S, U,
W, Y, AA

ClinicID2 –
ClinicID10

If applicable, enter all the clinics where the provider practices (up to 10 clinics). Enter the clinic IDs in
order, beginning with the clinic site in which the highest count of claims are billed (column K) and
ending with the clinic site in which the lowest amount of claims are billed (column AA).

L, N, P, R,
T, V, X, Z,
AB

FTEClinic2 –
FTEClinic 10

Enter the full-time equivalent (FTE) value of each provider in number format (e.g., 0.60, 0.75, 1.00)
that corresponds to the ClinicID2 (column K) – ClinicID10 (column AA) for other clinic sites where the
provider practices. Refer to Appendix E for assistance.
If the FTE is less than 0.1, round up to 0.1.
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Section V: MNCM Data Portal User Maintenance
To strengthen the security of the medical group’s data in the MNCM Data Portal, review active Data Portal Users
for the medical group at least annually and deactivate any Users that should no longer have access to the Data
Portal.

To access list of active users and deactivate users:

1. Click on the Users tab.
2. Click Deactivate on the right side of the listing for the User to be deactivated.

If a User has been incorrectly deactivated, contact support@mncm.org.
New Users: See Appendix C for instructions to request a User account.
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Appendices
Appendix A: Statewide Quality Reporting and Measurement System
State health reform law was passed by the Minnesota Legislature in 2008. Under this law with specific directives
within Minnesota Statutes, section 62U.02, all physician clinics are required to register and submit data on
measures to be publicly reported to the Commissioner of Health. To implement physician clinic registration
and the collection of quality measurement data, the Minnesota Department of Health (MDH) developed the
Minnesota Statewide Quality Reporting and Measurement System (SQRMS), created through Minnesota
Administrative Rules, Chapter 4654. To view the cited Statutes and Rules, please refer to the following website:
https://www.revisor.mn.gov/pubs.
MDH has contracted with MNCM to assist with SQRMS implementation. Under this contract, MNCM supports
physician clinics in meeting registration and measure requirements. To learn more about SQRMS and state
requirements, please refer to the following website:
http://www.health.state.mn.us/healthreform/measurement/
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Appendix B: Clinic and Medical Group Naming Conventions
When registering medical group and clinic information, be aware that the names registered in the MNCM Data
Portal will be used exactly as entered for a variety of public reporting purposes including MNHealthScores.org,
the Health Care Quality Report, the Health Care Disparities Report, the Health Equity of Care Report and
numerous MDH products. Please use naming conventions recognized and understood by the general public.
Naming Tips:
•

Double check the spelling in all fields;

•

Use the proper case. For example, enter Northern Health Center versus northern health center or
NORTHERN HEALTH CENTER;

•

If using hyphens or commas, ensure that the same spacing is used for all names;

•

Do not utilize the pipe character (e.g., Northern Health Center | Health Plaza), this character causes
issues with data extraction;

•

Only use abbreviations where absolutely necessary

Multiple clinic sites:
If there is more than one clinic site, the suggested naming convention is the medical group first, then space
hyphen space, then the clinic site name (e.g., Northern Health Center – Anytown, versus simply Anytown).
Multi-specialty clinic site:
If a multi-specialty medical group opts to register each specialty as individual clinics, the suggested naming
convention is the name of the clinic site first, then space hyphen space, then the specialty name. For example:
•

Northern Health Plaza – Family Medicine

•

Northern Health Plaza – Internal Medicine

•

Northern Health Plaza – Dermatology

•

Northern Health Plaza – Urgent Care

•

Northern Health Plaza – Main Clinic

The medical group name may also be included in front of the clinic name for clarity if this would be more
recognizable to patients (e.g., Northern Health Center – Health Plaza – Family Medicine).
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Appendix C: Accessing and Navigating the MNCM Data Portal
To request a User account in the MNCM Data Portal:
1. Navigate to the MNCM Data Portal: https://data.mncm.org/login
2. Under Registration, click register or Click Here.

3. Complete the required information.
a. Enter the Organization name exactly as it appears or should appear in the MNCM Data Portal
and in public reports.

4. Click Submit.
a. MNCM Data Portal User account requests are reviewed and verified by MNCM staff prior to
approval. MNCM staff will respond as soon as possible.
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5. Upon initial log-in to the MNCM Data Portal:
a. Reset password.
i. Enter new password and repeat new password and click Change Password.
b. Agree to Site Terms of Use
i. Click applicable checkbox and click OK.
ii. Failure to agree to Site Terms of Use will preclude user from utilizing the MNCM Data
Portal.
Returning MNCM Data Portal Users that have forgotten their password must click I forgot my password on the
MNCM Data Portal log-in page. Enter the email address that was used to create the user account, and a
temporary password will be generated and sent to the email address associated with the account.

Navigating the MNCM Data Portal
•

HOME: Displays information about all the current measures and deadlines for which the medical group
is responsible for submitting data.

•

GROUP and CLINICS: Displays
information about the
medical group and clinic sites.
If needed, edit information
for the group or clinic sites
under these tabs.

•

PROVIDERS: Displays all of
the information about
providers submitted during
registration.

•

CONTACTS: Lists all contacts
for the medical group. Add, remove, or edit a contact person here.

•

RESULTS: Displays data results and file downloads from prior submission cycles.

•

RESOURCES: Organized by topic or measure; contains information about SQRMS, data collection guides,
tools, and frequently asked questions by topic.

•

USERS: Lists all MNCM Data Portal users for the medical group. Deactivate users here.
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Appendix D: Information Required for Registration
Medical Group and Clinic Information
•

Medical Group and Clinic Names

•

Tax Identification Number (TIN) for the medical group and individual clinic sites (if different from the
medical group TIN)

•

Addresses and other contact information for the medical group and clinic sites
o Enter only the first five digits of the zip code of the medical group/clinic; and
o Enter the street address in the first address box and enter the suite number or other
information (such as a P.O. Box number) in the second address box.

•

Contact names and contact information for medical group and clinics

•

Unique National Provider Identifier (NPI) numbers for each clinic site
o Use each NPI once for each unique provider and each unique clinic site when available
 Note: If a clinic is a rolled-up clinic OR a specialty area/department within a larger clinic,
it might not have a unique NPI.

•

Electronic medical record (EMR) vendor name

•

Specialty(ies) that are practiced at each clinic site

Provider Information
•

Unique NPI numbers for each provider
o Ensure an NPI is submitted for every provider with an NPI
o For resident providers and other providers who do not have an NPI, enter ten 9s (9999999999)
in the NPI field
o For resident providers and other providers who do not have an NPI, create a unique provider ID
to be used for the provider during registration and data submission purposes

•

Primary board certified specialty of each provider

•

Names (First, Middle, Last) of all providers

•

Full-time equivalent (FTE) status for each provider (e.g., .60, .75, 1.00)
o See Appendix E for guidance

•

Unique medical license number for each provider.
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Appendix E: Full-time Equivalent (FTE) Calculation by Clinic Site Examples
FTE values should best reflect the time the provider practiced in a typical work week at each clinic site over the
course of the 2017 calendar year (01/01/2017 to 12/31/2017).
FTE Calculation:
Two options are available to calculate provider FTE. Choose the option most appropriate considering the data
available about the hours worked by providers at the clinic during the calendar year.
Option 1: For clinic sites where total hours worked by providers over the course of the calendar year are known.
Use the following formula to calculate FTE for each provider, for each clinic site where the provider practiced:
FTE = h ÷ 2080
where: h = total hours worked by the provider at the clinic site over the course of the calendar year
Definitions:
Total hours worked: The number of hours during the calendar year in which a provider worked at the clinic site.
Hours should include PTO, vacation, and holidays. When feasible, extended leaves such as maternity leave or
sabbatical should not be included.
NOTE: All instructions in Appendix E beyond this point support Option 2.
Option 2: For clinic sites where total hours worked by providers over the course of the calendar year are not
known. Use the following formula to calculate FTE for each provider, for each clinic site where the provider
practiced:
FTE = (h ÷ 40) × (m ÷ 12)
where: h = total hours worked by the provider at the clinic site in a typical work week AND
m = total months worked by the provider at the clinic site during the calendar year
NOTE: If a provider worked at more than one clinic site during the calendar year, this formula should be used to
calculate a separate FTE specific to each clinic site at which the provider worked. For example, if a provider
worked at three separate clinic sites during the calendar year, the responder should calculate three separate FTE
values for the provider.
Definitions:
Total hours worked in a typical work week: The best approximation of the average hours a provider most often
worked during the course of a week at a clinic site while employed at the clinic site during the calendar year.
Calculation: Total hours worked in a typical day × total days worked in a typical week = total hours
worked in a typical work week.
Example: In a typical work week a provider worked at the clinic five days for eight hours. Multiply five by
eight (5X8) for a total of 40 hours in a typical work week.
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Total months worked at the clinic site: The number of months during the calendar year in which a provider
worked at least one day at the clinic site.
Example: If a provider worked at the clinic January-September, but was on leave for all of July, please
report eight months instead of nine.
FTE calculation steps:
Please access the FTE Excel Template calculation tool available under the Resource tab on the MNCM Data
Portal for assistance in calculating the FTE for each provider. The steps below can also be used to calculate an
FTE for each clinic site at which the provider worked during the calendar year. The value calculated in step 3 is
the FTE for a clinic site.
Step

Calculation

Enter Values

1

Multiply: (Total hours worked in a typical day) × (Total days worked in a typical week)

2

Divide: (Answer to Step 1) ÷ 40

3

Divide: (Total months worked at the clinic site in CY 2017) ÷ 12

4

Multiply: (Answer to Step 2) × (Answer to Step 3)

FTE: _____
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Example Scenarios:
Example

# Clinic Sites

One Clinic,
More than full-time
12 months of the year
Mon.-Sat.; 8 hours/day;
48 hours/week

1

Three clinics, More than fulltime
12 months of the year
Clinic A:
Mon., Tues.; 8 hours/day; 16
hours/week
3
Clinic B:
Wed., Thurs.; 8 hours/day; 16
hours/week
Clinic B:
Fri., Sat.; 8 hours/day; 16
hours/week

Formula

FTE Value(s) to
enter in the in the
provider file

Step 1: Clinic A = 6 days/week x 8 hours/day = 48 hours/week
Step 2: 48 hours/week ÷ 40 hours/week = 1.20
Step 3: 12 months worked ÷ 12 months = 1.00
Step 4: 1.20 × 1.00 = 1.20

1.20 in
FTEClinicPrimary

Step 1: Clinic A = 2 days/week x 8 hours/day = 16 hours/week
Step 2: 16 hours/week ÷ 40 hours/week = 0.40
Step 3: 12 months worked ÷ 12 months = 1.00
Step 4: 0.40 × 1.00 = 0.40

0.40 in
FTEClinicPrimary

Step 1: Clinic B = 2 days/week x 8 hours/day = 16 hours/week
Step 2: 16 hours/week ÷ 40 hours/week = 0.40
Step 3: 12 months worked ÷ 12 months = 1.00
Step 4: 0.40 × 1.00 = 0.40

0.40 in FTEClinic2

Step 1: Clinic C = 2 days/week x 8 hours/day = 16 hours/week
Step 2: 16 hours/week ÷ 40 hours/week = 0.40
Step 3: 12 months worked ÷ 12 months = 1.00
Step 4: 0.40 × 1.00 = 0.40
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Example

# Clinic Sites

One clinic,
Full-time
Mon.-Fri.; 8 hours/day;
40 hours/week
6 months of the year

Three clinics,
Full-time
Mon.-Fri.; 8 hours/day;
40 hours/week
Clinic A:
6 months of the year
Clinic B:
4 months of the year
Clinic C:
2 months of the year

1

Formula
Step 1: Clinic A = 5 days/week x 8 hours/day = 40 hours/week
Step 2: 40 hours/week ÷ 40 hours/week = 1.00
Step 3: 6 months worked ÷ 12 months = 0.50
Step 4: 1.00 × 0.50 = 0.50
Step 1: Clinic A = 5 days/week x 8 hours/day = 40 hours/week
Step 2: 40 hours/week ÷ 40 hours/week =1.00
Step 3: 6 months worked ÷ 12 months = 0.50
Step 4: 1.00 × 0.50 = 0.50

3

Step 1: Clinic B = 5 days/week x 8 hours/day = 40 hours/week
Step 2: 40 hours/week ÷ 40 hours/week = 1.00
Step 3: 4 months worked ÷ 12 months = 0.33
Step 4: 0.33 × 1.00 = 0.33
Step 1: Clinic C = 5 days/week x 8 hours/day = 40 hours/week
Step 2: 40 hours/week ÷ 40 hours/week = 1.00
Step 3: 2 months worked ÷ 12 months = 0.167
Step 4: 1.00 × 0.167 = 0.167
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Example
One clinic,
Part-time
every other Thurs.;
8 hours/day;
8 hours/2 weeks
9 months of the year
Two clinics,
Part-time
Clinic A:
First 6 months of the year
Mon., Wed.; 8 hours/day;
16 hours/week
Clinic B:
First 6 months of the year
Fri.; 8 hours/day;
8 hours/week

# Clinic Sites

Formula

1

Step 1: Clinic A = 1 days/2 weeks x 8 hours/day = 4 hours/1 week
Step 2: 4 hours/1 weeks ÷ 40 hours/week = 0.10
Step 3: 9 months worked ÷ 12 months = 0.75
Step 4: 0.10 × 0.75 = 0.075

Step 1: Clinic A = 2 days/week x 8 hours/day = 16 hours/week
Step 2: 16 hours/week ÷ 40 hours/week = 0.40
Step 3: 6 months worked ÷ 12 months = 0.50
Step 4: 0.40 × 0.50 = 0.20

FTE Value(s) to
enter in the in the
provider file

0.075 in
FTEClinicPrimary

0.20 in
FTEClinicPrimary

2
Step 1: Clinic B = 1 day/week x 8 hours/day = 8 hours/week
Step 2: 8 hours/week ÷ 40 hours/week = 0.20
Step 3: 6 months worked ÷ 12 months = 0.50
Step 4: 0.20 × 0.50 = 0.10
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Appendix F: How to Create a CSV File (.csv)
Before proceeding with the file submission, be sure to:
• Complete all data collection and data entry.
• Verify that each column is formatted according to measure specifications (TEXT, NUMBER, or DATE
formatting). Columns can be any width.
• Verify that all original columns remain in the spreadsheet even if there is no data in a column. Do NOT
delete any columns.
Once the above steps are completed:
1. Save the Excel template.
2. Save the file in CSV format.
a. The CSV file will be the data file uploaded to the MNCM Data Portal.
How to create a CSV file from an Excel file:

For Excel 2003 Users
For Excel 2007 Users
For Excel 2010, 2013 & 2016 Users
1. Open the original Excel file (.xls).
2. Activate the worksheet to be uploaded by clicking the worksheet tab.
3. Click File, Save As.
3. Click the Office Button (upper
3. Click the File tab (upper leftleft-hand corner of screen);
hand corner of screen); select
select Save As.
Save As.
4. Navigate to the folder where the file will be saved.
5. Enter the file name.
6. At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save as type drop-down.
7. Click Save. The following warning will appear: “…may contain features that are not compatible with CSV. Do
you want to keep the workbook in this format?” Click Yes.
8. Close the file. A message will appear: “Do you want to save this file...?” Click Yes or No.

NOTE: If corrections to the data are needed after the CSV file has been created; do NOT open the CSV file in
Excel to make these corrections. Doing so alters the data. To make changes, follow these steps:
1. Open the original Excel template.
2. Make changes in the Excel template.
3. Save the Excel template.
4. Save the file with the changes as a new CSV file.
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Appendix G: Glossary of Terms
Assignment: The process by which clinics are assigned to clinical quality measures, for which they are
responsible to report data to MNCM. Assignments are based on provider specialties practiced at each clinic.
These specialties are selected by the medical group during clinic registration.
Clinic: The individual practice site or sites that are registered under the main medical group. Clinics are locations
where primary or specialty care ambulatory services are provided for a fee by one or more physicians.
A clinic site location is a building, separate space or an entity with a street address. It should be a functional unit
that is easily understood by patients/consumers. The goal of reporting by clinic site is to provide
patients/consumers with information about the entity with which they are most familiar and to provide
information to clinics that is actionable for quality improvement purposes.
Clinic and Provider Registration: The annual process by which clinics and providers register on the MNCM Data
Portal. Providers who worked at a clinic site during the previous calendar year must be registered.
Clinic ID: Assigned to a clinic by the MNCM Data Portal when the clinic first registers.
Clinical Staff: Licensed individuals who provide medical services at a clinic. Defined, for the purposes of Clinic
and Provider Registration, as the following provider types: physicians (MD or DO), advanced practice registered
nurses (e.g., Certified Nurse Practitioner, Certified Nurse Specialist, and Certified Nurse Midwife) and physician
assistants (PA).
Contacts Tab: The tab in the MNCM Data Portal that lists all contacts for a particular medical group and where
medical groups can add, remove or edit contacts. While changes can be made at any time, this information must
be updated by medical groups during Clinic and Provider Registration.
CSV File: Acronym for comma separated values. A CSV file is a common and simple format that is used to
import/transport data between systems or software applications that are not directly related (e.g., from a
spreadsheet to a database). All data submission files are formatted as CSV files.
Excel Format: Format of Excel template columns necessary to submit data file to MNCM Data Portal.
Errors: The error and warning report will be displayed after a data file is submitted via the MNCM Data Portal.
Errors are “hard stops” in the Data Portal that result in the submission of a file not being allowed. They must be
corrected and a revised data file must be uploaded to the Data Portal before submission can occur.
Full-Time Equivalent (FTE): The best reflection of the time the provider practiced in a typical work week at each
clinic site over the course of a calendar year. FTE information is submitted during Clinic and Provider
Registration in the provider registration step.
Group and Clinic Sites Tabs: These tabs display information about the medical group and clinic sites in the
MNCM Data Portal. Information can be edited for the group or clinic sites as needed.
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Home Tab: This tab displays information about all the current measures and deadlines for which the medical
group is responsible.
Hospital-Based Outpatient Clinic Locations: These are included in the physician clinic definition and must be
registered and report required measures.
Medical Group: The highest level of the MNCM Data Portal clinic and provider registration construct. The
medical group represents a single, centralized organization that operates one or more clinic sites. Organizations
define the parameters of the medical group at the time of registration and may choose to divide clinics operated
by the organization into more than one medical group. Medical groups with only one clinic site must enter
information under both the medical group and clinic sections, even though the information will be the same.
When reporting on the clinical quality measures, data for all clinic sites is submitted to MNCM in one file via the
medical group.
Medical Group ID: Assigned to a medical group by MNCM when the medical group first registers.
MNCM Data Portal: Secure, HIPAA-compliant portal owned by MNCM where clinics/medical groups can submit
patient-level data for validation and accurate calculation of results.
Multi-Specialty Clinics: A clinic site that has multiple specialties located in one building (i.e., one street address).
Medical groups have the option to register a single clinic site or register each specialty as its own clinic site and
then also register a main clinic site. How clinics decide to register depends on how the clinic desires to have their
clinical measures publicly reported on MNHealthScores.org.
National Provider Identifier (NPI): A unique identifier for individual providers or organizations that render
health care. Health care providers who are HIPAA-covered entities obtain an NPI to identify themselves in HIPAA
standard transactions. Also referred to as Provider ID.
Newly Opened/Acquired Clinics: If a medical group opened or acquired a new clinic in the last year, the new
clinic must be registered with the medical group and must submit data with the medical group. If the new clinic
uses a different practice management system, billing system or EMR, they should follow the same instructions
and measure specifications to collect the data, and the medical group should include the new clinic’s data in the
data submission to MNCM.
Primary Data Contact: The person from the medical group who uploads/submits data files for the clinical quality
measures; receives communications from MNCM about data submission and other important updates; and
completes the medical group’s annual registration of the clinics and clinical staff on the MNCM Data Portal. It is
important that the Primary Data Contact information for medical groups remains up-to-date to ensure MNCM
communication is received by the appropriate person in a timely manner.
Provider File: Excel Template available on the MNCM Data Portal for Clinic and Provider Registration. This
document is uploaded to the MNCM Data Portal during registration.
Provider ID: Created by medical group/clinic for providers who do not have an NPI. This ID will be used in the
data file submission to MNCM.
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Provider Type: Medical Doctor (MD, including physicians who have medical degrees from other countries such
as MBBCH, MBBS, MBCHB); Doctor of Osteopathy (DO); Physician Assistant (PA) or Advanced Practice Registered
Nurse (e.g., Certified Nurse Practitioner, Certified Nurse Specialist, Certified Nurse Midwife) are providers that
are required to be registered during Clinic and Provider Registration. Refer to the specific measure specifications
for eligible provider types required to report clinical data for each measure as they differ.
Provider Specialty Code: Codes generated by MNCM to indicate the board certified specialty of providers. The
codes are included in the provider registration file and DDS data file. Please see the Clinic and Provider
Registration Instructions guide as well as each data collection guide for further guidance.
Providers Tab: This tab displays all of the information about providers submitted during Clinic and Provider
Registration.
Resources Tab: This tab is organized by topic or measure and includes data submission guides, tools and
frequently asked questions by measure.
Roll-up: Process by which multiple clinics report data under one clinic. Clinics can report data as one clinic if they
meet all of the three following criteria: 1) have common ownership; 2) have a majority (more than half) of
common clinical staff working across the multiple locations (these clinical staff must rotate between all of the
clinic locations); and 3) the total clinical staff across all locations is no greater than 20 FTEs. Please see clinical
staff for further details.
Satellite Clinics: A type of clinic that bill services through a main site. This clinic type is not required to register.
Statewide Quality Reporting and Measurement System: State health reform law passed in 2008. Under this law
with specific directives within Minnesota Statutes, section 62U.02, all physician clinics are required to register
and submit data on measures to be publicly reported to the Commissioner of Health. To implement physician
clinic registration and the collection of quality measurement data, MDH developed SQRMS, created through
Minnesota Rules, Chapter 4654. MDH has contracted with MNCM to assist with implementing SQRMS. Under
this contract, MNCM supports physician clinics in meeting registration and measure requirements.
Urgent Care Clinics: A type of walk-in clinic, either stand-alone or offered as a service of a multi-specialty clinic,
that primarily treats illness or injuries requiring immediate care, but not serious enough to require an ER visit.
Stand-alone urgent care clinics must register and complete an annual Health Information Technology (HIT)
survey; however, urgent care clinics are not required to report on clinical quality measures.
Warnings: The error and warning report is displayed in the MNCM Data Portal after data file submission.
Warnings should be reviewed to determine if corrections are needed.
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2018 Annual Clinic and Provider Registration
Addendum
Other Provider Registration
Active engagement to submit data to a specialized or clinical data registry, such as MN Community
Measurement, is an objective in the Advancing Care Information Objectives and Measures for the Merit-based
Incentive Payment System (MIPS) track of CMS’s Quality Payment Program (QPP). Providers registered in the
MNCM Data Portal may receive a bonus in the Advancing Care Information (ACI) performance category for
meeting this objective. All providers registered in the MNCM Data Portal, including those that are required and
those that are not required to register under the Statewide Quality Reporting System (SQRMS), may meet this
objective.
The instructions in this addendum are intended to be used by clinics who wish to use MNCM’s registration
process to register providers that fall outside of the SQRMS mandate for the purposes of meeting this MIPS ACI
objective or other reporting requirements. This registration step is to be completed after the registration of
providers that are required to register under the SQRMS mandate.
Examples of providers that may be registered in this step include, but are not limited to:
•
•
•
•
•

Dieticians
Chiropractors
Licensed counselors
Pharmacists
Physical therapists

•
•

•

Podiatrists
Occupational therapists
Optometrists

It is the Eligible Clinician’s (EC) responsibility to interpret the federal rule. MNCM does not report
objectives/measures for the MIPS ACI performance category to CMS. Information about the ACI performance
category and associated objectives and reporting options can be found at qpp.cms.gov.
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STEP 1
Register all providers that
meet SQRMS criteria.

STEP 2
Complete Provider
Registration Quality Checklist

STEP 3
(OPTIONAL)
If desired, register additional
providers for other programs.
Instructions in this Addendum

STEP 4
Review registered provider
information and confirm.

See Annual Clinic and Provider Registration Instructions

Medical Groups that have previously registered Other Providers:
1. Complete registration of all providers, including new providers, required to register to meet SQRMS
mandate requirements.
Steps 1 and 2 in the above flow chart. Instructions to complete these steps can be found in
Section IV of the Annual Clinic and Provider Registration Instructions.
2. To download a list of previously registered providers and their information on the MNCM Data Portal,
scroll to the bottom of the Other Providers page and click Download in Upload Format.
•

•

An Other Provider Registration Spreadsheet file in CSV format will open with all of the
provider information that was registered previously.

•

Execute the Save As function and save the file in Excel format (.xls or .xlsx).

NOTE: The format for the Other Provider Registration Spreadsheet template is not the same
as the Provider Template used to register providers to meet SQRMS mandate requirements.
See Other Provider Registration Data Elements and Field Specifications table for formatting
information.
3. Update the Other Provider File to reflect changes from the previous registration.
•

•

Add new providers and delete providers no longer with the medical group.

•

Update each field as necessary (e.g., new clinic IDs, etc.) for providers who will be registered
again under the medical group.

• Review the file for accuracy.
4. When all the information is updated save the file keeping it in Excel format.
5. From the Excel file, save a new CSV-format file (.csv). See page 9 for information on how to save a CSV
file.
6. Upload the CSV file onto the MNCM Data Portal.
• NOTE: Uploading a new file will completely overwrite previously registered providers.
7. After uploading the CSV file, review the provider information on the MNCM Data Portal. If changes to
the provider information are necessary, make changes in the original Excel file, re-save as a CSV file and
re-upload the file. If no changes are necessary, click Complete Other Providers Step to confirm provider
registration.
8. Click Done to finalize provider registration.
•

Step 4 in the flow chart above. Instructions to complete these steps can be found in Section
IV of the Annual Clinic and Provider Registration Instructions.
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Medical Groups newly registering Other Providers:
1. Complete registration of all providers, including new providers, required to register to meet SQRMS
mandate requirements.
Steps 1 and 2 in the above flow chart. Instructions to complete these steps can be found in
Section IV of the Annual Clinic and Provider Registration Instructions.
2. Download and complete the Excel Other Provider Registration Spreadsheet template available in the
MNCM Data Portal on the RESOURCES tab by selecting “Annual Clinic and Provider Registration
Information” from the drop-down menu.
•

NOTE: The format for the Other Provider Registration Spreadsheet template is not the same
as the Provider Template used to register providers to meet SQRMS mandate requirements.
The Excel Other Provider Registration Spreadsheet template is formatted correctly for
uploading to the MNCM Data Portal. It is important that this formatting remain the same.
See Other Provider Registration Data Elements and Field Specifications table for
information.
Enter all information and save as an Excel file.
From the Excel file, save a new CSV-format file (.csv) and upload the CSV file onto the MNCM Data
Portal. See page 9 for information on how to save a CSV file.
After uploading the CSV file, review the provider information on the MNCM Data Portal. If changes to
the provider information are necessary, make changes in the original Excel file, re-save as a CSV file and
re-upload the file. If no changes are necessary, click Complete Other Providers Step to confirm provider
registration.
Click Done to finalize provider registration.
•

3.
4.
5.

6.

•

Step 4 in the flow chart above. Instructions to complete these steps can be found in Section
IV of the Annual Clinic and Provider Registration Instructions.
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To save confirmation of registration for all providers that are attesting to Specialized or Clinical Data Registry
Reporting for the ACI performance category of MIPS:
Active Engagement Confirmation Letter
o Click on the Resources tab and select ACI Documentation from the dropdown.
o Click the Download ACI Documentation link to generate documentation of active engagement
with MN Community Measurement.
o Save and/or print the PDF letter.
• List of Registered Providers:
o Click on the Providers tab to see a complete list of all providers registered in the MNCM Data
Portal and the date on which they were registered.
o Save and/or print the provider lists including the medical group name, confirmation date, and
MNCM logo at the top of the screen.
Additional documentation to retain in case of CMS audit of applicable ACI measures:
•

•
•

Dated record of successful clinical measure data transmission (e.g., screenshot of MNCM Data Portal),
including evidence to support that it was generated for that provider; OR
Letter or email from registry confirming receipt of submitted clinical measure data, including the date of
submission and name of sending and receiving parties (e.g., auto generated email from MNCM Data
Portal at time of data submission).
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Other Provider Registration Data Elements and Field Specifications
Column

Field Name

Details

A-C

Provider Name

Enter names for the following fields:
•
•
•

D

E

Excel Format
Last name (Column A)
Full first name (Column B)
Middle name, if available (Column C)

Provider ID
[created by
medical group]
(Optional)

Leave this field blank for providers with an NPI listed in Column E.

National
Provider
Identifier (NPI)

Enter the unique 10-digit NPI for each provider being registered. Please review all entered NPIs
to ensure correct entry for each individual provider.

For providers without an NPI (e.g., residents), enter a provider ID. This may be an ID used in the
EMR or a unique ID that is assigned by the medical group.

•

For residents without an NPI, enter ten 9s – (9999999999)

•

For providers with an NPI, use a distinct NPI value for each unique provider.

NPI is a unique identifier for individuals or organizations (clinics) that render health care. Health
care providers who are HIPAA-covered entities obtain an NPI to identify themselves in HIPAA
standard transactions.
NPIs that are duplicative of NPIs of providers registered to meet SQRMS mandate
requirements will cause an ERROR on submission.
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Addendum
Other Provider Registration
Column

Field Name

Details

F

Provider Type
(Optional)

Enter the applicable provider type. Examples of provider types include but are not limited to:
•
•
•
•
•
•
•
•

Excel Format

Dietician
Chiropractor
Licensed Counselor
Occupational Therapist
Optometrist
Pharmacist
Physical Therapist
Podiatrist

DO NOT enter SQRMS defined provider types in this file (MD, DO, PA, and APRN that deliver
care in a clinical setting).
NOTE: This is a free text field. Enter the provider type as you would like it to appear in the
MNCM Data Portal. Please review for spelling and consistency.
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Column

Field Name

Details

G

Board Certified
Specialty
(Optional)

Using the following list of codes, enter the code of the provider’s primary board-certified
specialty. If the provider does not have a board certified specialty, leave the field blank. If a
code is not listed for an applicable specialty listed (e.g., Urgent Care, Sports Medicine, etc.),
enter 99 Other – not listed.
10
6
11
35
12
13
14
7
1
15
5
2
16
17
18
9

H

Medical License
Number
(Optional)

Excel Format

19
20
21
22
23
24
31
25
8
26
32
27
28
29
30
99

Allergy/Immunology
Cardiology
Cardiovascular Surgery
Chiropractic Medicine
Colon and Rectal Surgery
Dermatology
Emergency Medicine
Endocrinology
Family Medicine
Gastroenterology
Geriatric Medicine
Internal Medicine
Nephrology
Neurology
Neurosurgery
Obstetrics/Gynecology

Occupational Medicine
Oncology/Hematology
Ophthalmology
Orthopedic Medicine/Surgery
Otolaryngology
Pediatric/Adolescent Medicine
Perinatology
Physical Therapy/Rehabilitation Medicine
Psychiatry/Behavioral Health
Pulmonary Medicine
Radiation Oncology
Radiology
Rheumatology
Surgery
Urology
Other – not listed

Text

Enter the medical license number of each provider listed in the file.
Text
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Column

Field Name

Details

I

Clinic ID Primary
(Optional)

Enter the MNCM ID listed in the MNCM Data Portal for the clinic where the provider primarily
practices (e.g., the clinic ID of the clinic where the majority of the provider’s claims are billed
from).
Do not enter the medical group ID.

ClinicID2 –
ClinicID10
(Optional)

If applicable, enter all the clinics where the provider practices (up to 10 clinics).

J, K, L,
M, N, O,
P, Q and
R

Excel Format
Text

Text
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Data File Creation
Before proceeding with the file submission, be sure to:
•

Complete all data collection and data entry.

•

Verify that each column is formatted according to field specifications (TEXT, NUMBER, or DATE
formatting). Columns can be any width.

•

Verify that all original columns remain in the spreadsheet even if there is no data in a column.
Do NOT delete any columns.

Once the above steps are completed:
1. Save the Excel template.
2. Save the file in CSV format.
a. The CSV file will be the data file uploaded to the MNCM Data Portal.
How to create a CSV file from an Excel file:
For Excel 2003 Users

For Excel 2007 Users

For Excel 2010, 2013, & 2016 Users

1. Open the original Excel file (.xls).
2. Activate the worksheet to be uploaded by clicking the worksheet tab.
3. Click File, Save As.

3. Click the Office
Button (upper
left-hand corner
of screen); select
Save As.

3. Click the File tab (upper
left-hand corner of screen);
select Save As.

4. Navigate to the folder where the file will be saved.
5. Enter the file name.
6. At the bottom of the Save As dialog box, choose CSV (comma delimited) from the Save
as type drop-down.
7. Click Save. The following warning will appear: “…may contain features that are not
compatible with CSV. Do you want to keep the workbook in this format?” Click Yes.
8. Close the file. A message will appear: “Do you want to save this file...?” Click Yes or No.
NOTE: If corrections to the data are needed after the CSV file has been created; do NOT open the CSV
file in Excel to make these corrections. Doing so alters the data. To make changes, follow these steps:
1. Open the original Excel template.
2. Make changes in the Excel template.
3. Save the Excel template.
4. Save the file with the changes as a new CSV file.
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